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1.1  Program Overview 

 
A Post-processing Utility 

 

PostSearch™ is a database search post-processor.  It helps searchers clean up, further query, and edit database search 

files in preparation for final formatting in their word processors.  Its clean-up filters support certain named database 

services such as DIALOG and STN and operate on screen-captured, plain text search file. 

 

PostSearch™ is utility software used in conjunction with other software.  The sequence of using PostSearch™ is: 

 

1. searcher's communication software: 

a. start the communication software 

b.  turn on screen capture to save all screen data from the entire session to disk file 

c. connect to database service and do the search 

d. log off the database service and close the capture file 

 

2. PostSearch™: 

a. clean up the search with the filter for the system that was searched 

b. if desired, further query and edit the filtered search 

 

3. searcher's word processor: 

a. open PostSearch™ file in searcher's word processor 

c. perform final editing and formatting 

c. save/print final formatted data 

 

Function Groups 

 

The functions of PostSearch™ are grouped on its menus and toolbar under four main headings 
 

1. filtering 

2. content 

3. polish 

4. utilities 
 

Filtering cleans up a raw search file.  It is the root of post-processing in PostSearch™.  Most other functions are 

performed on filtered record files. 
 

The content and polish groups are similar in that both include functions to edit filtered record files.  The content 

group deals with more major content editing while the polish group deals with trimmings. (The Diction command is 

an except which, rather than performing any editing, allows the searcher to study the content of a search by 

generating a diction list.) 
 

Content Polish 
sift renumber record labels 
query by form delete record labels 
sort replace record labels 



rank insert page breaks 
create a diction list remove line breaks (hard carriage 

returns) in DIALOG TAGed records 
 divide records individually into 

separate files 
 undelimit DIALOG TAGed records 
 create a file header or cover page 

 

Filtering 
 

Filtering is the root of post-processing in PostSearch™.  Most other functions are performed on filtered record files. 
 

Filtering means to clean up a database search.  The contents of a captured search file are passed through a filter to 

screen out everything but the records.  Logon sequences, menus, prompts, help screens, expanded terms, etc. are 

filtered out.  The filters label and number the records in the form “Record -1”, “Record -2”, etc. 
 

Sifting 
 

Sifting means to edit a filtered search on a record-centered basis.  Though a filtered record file is sheer text, not a 

database, and though the records are of variable length, the sifter commands can act at once on a whole record as a 

discrete unit.  You can: 
 

• view records, navigating through them record-by-record (rather than line-by-line or page-by-page as in a 

word processor) with the commands Next, Previous, First, Last and Jump (directly to a record by number) 
 

• write chosen records to one or many new files with the commands Keep, Keep Express, and Write Kept with 

no need to highlight, cut-and-paste, perform block operations or otherwise manipulate the text constituting a 

record 
 

• reorder records with the commands Order and Write Order, specifying the currently displayed record’s new 

order by simply typing a number. 
 

Query by Form 
 

The Query command applies query-by-form (QBF) to a filtered record file.  Records selected by the query are 

written to a new file.  The query form implements Boolean operators, nesting and truncation. 
 

Rank 
 

Ranking reorders records by weighted frequency of terms.  You can specify up to six terms with or without right 

truncation assigning each a weight from 1 to 9. 
 

Sort 
 

Sorting alphabetizes records on a field.  For example, you can alphabetize records by author by specifying the AU- 

field.  Sorting requires field tags at the left. 
 

Divide 
 

You can divide the records in a file to separate files, one record to a file.  PostSearch™ automates this process. 
 

Renumber 
 

Sifting (keeping and reordering), QBF, ranking and sorting produce files with the record labels out of numerical 

order.   A sifted file might have labels 3, 9, 22, etc., because those were the records you  “kept.”  PostSearch™ 

includes a facility to renumber record labels automatically, to change 3, 9, 22, etc. to 1, 2, 3, etc. 
 

Delete 
 

In case you prefer to have no record labels, they can be deleted automatically. 



Replace 
 

You might have a need to replace the record labels provided by PostSearch’s™ filters.  For example, in preparation 

for importing records into other software, you might need to mark the records with beginning and ending markers.  

PostSearch™ automates this process. 
 

Insert Page Breaks 
 

In preparation for printing, you might need to go through a file and insert page breaks.  For example, two abstracts 

might fit on each page, and you might not want an abstract split from page to page.  Or you might not want full text 

records to begin in the middle of a page, preferring that each one begin on a new page.  PostSearch™ allows page 

breaks to be inserted automatically every N records automatically. 
 

Remove Hard Carriage Returns 
 

In preparation for printing, you might want to remove hard carriage returns so that your word processor can have 

control of the margins, fonts, etc.   PostSearch™ can reformat DIALOG TAGed records to remove hard carriage 

returns within fields.  See Susan N. Bjorner, "Of Wits and Magic and Micro Worlds:  Removing Unwanted Carriage 

Returns from Search Output," Online, p. 85 (January 1992). 
 

Undelimit 
 

DIALOG TAGed records, beside having field tags at the left, such as “AN- ” for “accession number”, have field and 

record delimiters.  The field delimiter is a single vertical bar, |, and the record delimiter is a double vertical bar, ||.  

You might want the tags but not the delimiters.  PostSearch™ automates removal of the delimiters. 
 

Diction 
 

The Diction command creates a list of all words in a file, except those in an omit list.  The list is sorted from most 

frequent to least, and subsorted alphabetically.  A default omit list is supplied, and is user-editable. 
 

Header/Cover Page 
 

The Header/Cover Page command lets you create a stylized memo documenting the search, and either attach it to 

the data file as a header or as a separate cover page, or save the memo as a separate file. 
 

Utilities 
 

PostSearch™ includes some utilities to help with post-processing.  These include a file viewer, split files, access to 

the DOS prompt and configuration settings. 
 

Preservation of Files 
 

PostSearch™ preserves input files unaltered regardless of function.  Filtering, sifting, keeping, reordering, querying, 

ranking, sorting, record label changes, creating diction lists, removing hard carriage returns and page breaking all 

preserve the input files and create new output files.  When filtering, for example, your search is not altered.  

Filtering a file named SEARCH.LOG preserves that file unaltered and creates SEARCH.PRO (.PRO means 

"processed"). 

 

1.2  Install PostSearch™ 
 
The first distribution diskette includes a setup program which automatically copies the program files to your hard 

drive, decompresses them, places them in the correct directories, and updates the Registry. 
 

To use the setup program, insert distribution diskette labeled Disk1 into floppy Drive A: or Drive B: and do one of 

the following: 
 



• From the Start menu choose Settings, then Control Panel, then Add/Remove Programs.  This utility will 

locate the setup program on the diskette. 

• From the Start menu choose Run and type either A:SETUP.EXE or B:SETUP.EXE. 

• In Windows Explorer, select Drive A: or Drive B:, then double-click on SETUP.EXE. 
 

Of these methods, we recommend Add/Remove Programs. 

 

1.3  Online Help 
 
PostSearch™ provides online help four ways: 
 

• brief status messages at the bottom of the main screen which are sensitive to mouse pointer location 

• Help from the Help menu 

• Help by clicking the Help command buttons 

• context-sensitive Help by pressing the F1 key 

 

2.  Filter 
 

2.1  Filtering Generally 
 
What is a Captured Search File? 
 

The PostSearch™ clean-up filters operate on screen-captured, plain text search files.  PostSearch™ is not designed to 

work with files generated by specialty communication programs which add formatting or embed codes outside the 

7-bit ASCII character set.  It is not designed to work with graphics. 

 

Screen capture is a feature of most computer communication programs that lets you record the information scrolling 

up your screen during an online session and save it to a disk file on your computer.  This feature may also be called 

logging or recording. 

 

When your search request hits on records, you may command the system to immediately display the records.  If you 

have activated screen capture, your communication program will be saving everything, including the records, to a 

disk file on your computer.  PostSearch™ refers to a file created in this manner as a captured search file. 

 

Thus, the best procedure for searching when PostSearch™ will be used is: 

 

1. start the searcher’s communication software 

2. turn on screen capture to save all screen data from the entire session to disk file 

3. connect to database service and do the search 

4. log off the database service and close the capture file 

 

What The Filters Do 

 
Captured search files include other information transmitted to your computer during a search session besides just the 

records.  The other information includes menus, prompts, error messages, commands you enter, help messages, etc. 
 

You could try to remember to turn screen capture on and off as needed, but this is prone to error and distracts from 

focusing on the search.  With PostSearch™, you can turn on the capture feature of your communications program at 

the beginning of your search, capture everything without thinking about it, focus on your search, and then when 

offline use PostSearch™ to create a new file with everything filtered out except the records.  As the capture file is 

cleaned up, PostSearch™ automatically labels and numbers the records for you. 
 

PostSearch™ does not alter your capture file; it writes the filtered records to a new file. 

 



Content of Filtered Record File 

 
The filtered record file will consist of two kinds of segments, numbered record labels and record content: 
 

Record - 1 

 

record content 

 

Record - 2 

 

record content 

 

Record - 3 

 

record content 

 

An example from a search of ERIC is: 
 

Record - 1 

 

EJ426056 IR522936 

  The Seven Stages of an Online Search--Part I. 

  Quint, Barbara 

  Online; v15 n3 p13-18 May 1991 

  ISSN: 0146-5422 

  Available from: UMI 

  Language: English 

  Document Type: JOURNAL ARTICLE (080); CLASSROOM 

MATERIAL (050); POSITION PAPER (120) 

  Journal Announcement: CIJSEP91 

  Discussion of online searching focuses on the first 

three of seven stages of searching: (1) the reference 

interview, including user needs, the search request, 

and the user's expectations; (2) the tactical overview, including institutional control and 

cost and time factors; and (3) database selection considerations, including relevance, 

accessibility, and costs. (LRW) 

  Descriptors: Cost Effectiveness; Costs; Databases; 

Interviews; *Online Searching; Relevance (Information 

Retrieval); *Search Strategies; Time Management; *User 

Needs (Information) 

  Identifiers: *Query Negotiation (Library Science); 

User Fees 

 

Record - 2 

 

EJ428878 IR523115 

  Inside a Searcher's Mind: The Seven Stages of an 

Online Search--Part 2. 

  Quint, Barbara 

  Online; v15 n4 p28-35 Jul 1991 

  ISSN: 0146-5422 

  Available from: UMI 

  Language: English 

  Document Type: JOURNAL ARTICLE (080); CLASSROOM 

MATERIAL (050) 

  Journal Announcement: CIJNOV91 

  Continues a description of elements in the online 

searching process, highlighting: (1) search strategy 

formulation, including free text search construction 

versus controlled terminology, and terms and search 

statements; (2) the actual online search, including 

speed and cost considerations; (3) feedback or reviewing results; and (4) presentation of 

final search results in print or machine-readable format. (LRW) 

  Descriptors: Cost Effectiveness; Feedback; *Online 

Searching; *Search Strategies; Subject Index Terms; 

Thesauri; Time Management; User Needs (Information) 

  Identifiers: Free Text Searching; Machine Readable 

Data; Printed Materials 

 



2.2  Filter Non-DIALOG Searches 
 
Menu Steps 
 

1. Choose the Filter menu 

2. Choose a non-DIALOG system 

3. Specify a captured search file 
 

Filter Menu 
 

PostSearch™ lets you filter search files captured while searching a number of different systems.  Differences in the 

systems require different filters tailored to each system.  PostSearch™ includes filters for searches of DIALOG, 

Data-Star, Dow Jones News/ Retrieval //TEXT, STN, Ovid and National Library of Medicine.  For filtering to work 

properly, you must match the filter to the system. 
 

Filter Command Buttons 
 

PostSearch™ provides filter command buttons.  The command buttons provide a more direct route to filtering than 

does menu mode.  Steps 1 and 2 are accomplished by clicking on the appropriate button, which brings you directly 

to the Open dialog box. 
 

 

Open Dialog Box 
 

After choosing a system, the Open dialog box opens.  You may type the name of a file in the text box within the 

dialog box if you know it.  Otherwise you can use the file, directory and drive list boxes to locate and choose the file 

you want to filter.  Because the filter will name the output file with a .PRO extension, as explained below, you 

would not want to choose a file with that extension as the input file. 
 

Files Created and Preserved 
 

When you have specified the captured search file to be filtered, PostSearch™ opens a dialog box which tells you it is 

filtering.  It reports the progress of filtering, showing the line number and record number being processed.  It 

displays a meter showing the percentage of completion based on the number of lines in the file. 
 

PostSearch™ automatically names the filtered file with the same base name as the captured search file plus a .PRO 

extension. For example, if the captured search file is SEARCH.LOG, PostSearch™ will name the filtered record file 

SEARCH.PRO.  The .PRO extension means "processed."  PostSearch™ requires that extension later if you choose to 

sift or select records by key words. 
 

PostSearch™ preserves the captured search file without altering it.  In the example, when filtering is complete, the 

dialog box will display messages that SEARCH.LOG has been preserved unaltered and that SEARCH.PRO is where 

the filtered records have been saved. 
 

The sifter, should you choose to use it, needs an index of the filtered records.  It can create one from scratch by 

reading the filtered record file after the filter creates it, but the filter also creates indexes on-the-fly while filtering 

and saves them to disk files, with .NDX extensions.  If you filter SEARCH.LOG, the index file will be 

SEARCH.NDX.  The filter does this because if you choose to sift, loading an index from a disk file is much faster 

than having the sifter build it from scratch.  The key word record selector also uses indexes and behaves in regard to 

them the same as the sifter. 

 

2.3  DIALOG Filtering Options 
 
Options 
 

The filters for DIALOG searches provide additional flexibility.  You can filter all online types to one file, up to five 

specified types to one file, up to five specified types to separate files, or all offline prints delivered via DIALMAIL 



to one file. 

 

DIALOG Filtering Sub-Menu 
 

When you choose DIALOG from the Filter menu, the program presents  the DIALOG filtering sub-menu where you 

can choose to filter: 
 

• All Types to One File 

• Specified Types to One File 

• Specified Types to Separate Files 

• DIALMAILed Offline Prints to One File 
 

Option Buttons and Command Button 
 

PostSearch™ provides option buttons and a command button as an alternative route to choosing a DIALOG filtering 

option and filtering a DIALOG search.  The option buttons are shown on the DIALOG Filtering Options panel: 
 

 

With the mouse, you may simply click the option you choose, and then when you click on the DIALOG filter 

command button, the chosen option will be in effect.  When you first launch PostSearch™, the default option is to 

filter all online types to one file. 

 

2.4  Filter All Online Types to One File 

 
Menu Steps 
 

1. Choose the Filter menu 

2. Choose the DIALOG system 

3. Choose  the All Types to One File command 

4. Specify a captured search file 
 

Filter Menu:  Choose DIALOG 
 

PostSearch™ lets you filter search files captured while searching a number of different systems.  Differences in the 

systems require different filters tailored to each system.  PostSearch™ includes filters for searches of DIALOG, 

Data-Star, Dow Jones News/ Retrieval //TEXT, STN, Ovid and National Library of Medicine.  For filtering to work 

properly, you must match the filter to the system. 
 

Select DIALOG Filtering Option 
 

The filters for DIALOG searches provide additional flexibility.  You can filter all online types to one file, up to five 

specified types to one file, up to five specified types to separate files, or all offline prints delivered via DIALMAIL 

to one file. 
 

Choosing this filtering option, All Types to One File, lets you include all records of any online type in a single 

output file.  You may choose this filtering option from the menus or if you will be using the DIALOG filter 

command button, from the option buttons: 



 

Open Dialog Box 
 

After choosing this DIALOG filtering option, the Open dialog box opens.  You may type the name of a file in the 

text box within the dialog box if you know it.  Otherwise you can use the file, directory and drive list boxes to locate 

and choose the file you want to filter.  Because the filter will name the output file with a .PRO extension, as 

explained below, you would not want to choose a file with that extension as the input file. 
 

Files Created and Preserved 
 

The files created and preserved when filtering all DIALOG online types to one file are the same as when filtering 

non-DIALOG searches. 
 

In addition, PostSearch™ also attempts to create a separate file containing certain information about the search.  See 

Files, Sets and Costs Information. 

 

2.5  Filter Specified Online Types to One File 

 
Menu Steps 
 

1. Choose the Filter menu 

2. Choose the DIALOG system 

3. Choose the Specified Types to One File command 

4. Specify a captured search file to filter 

5. Choose the number of types to specify from 1 to 5 

6. Specify the online types 
 

Filter Menu:  Choose DIALOG 
 

PostSearch™ lets you filter search files captured while searching a number of different systems.  Differences in the 

systems require different filters tailored to each system.  PostSearch™ includes filters for searches of DIALOG, 

Data-Star, Dow Jones News/ Retrieval //TEXT, STN, Ovid and National Library of Medicine.  For filtering to work 

properly, you must match the filter to the system. 
 

Select DIALOG Filtering Option 
 

The filters for DIALOG searches provide additional flexibility.  You can filter all online types to one file, up to five 

specified types to one file, up to five specified types to separate files, or all offline prints delivered via DIALMAIL 

to one file. 
 

Choosing this filtering option, Specified Types to One File, lets you include only the online types you choose in a 

single output file.  You may choose this filtering option from the menus or if you will be using the DIALOG filter 

command button, from the option buttons: 
 



 

Open Dialog Box 
 

After choosing this DIALOG filtering option, the Open dialog box opens.  You may type the name of a file in the 

text box within the dialog box if you know it.  Otherwise you can use the file, directory and drive list boxes to locate 

and choose the file you want to filter.  Because the filter will name the output file with a .PRO extension, as 

explained below, you would not want to choose a file with that extension as the input file. 
 

How Many Types? 
 

When you have specified the captured search file to be filtered, PostSearch™ opens a dialog box to let you choose 

the number of online types to include in the output file, and then specify the types.  You may choose to include from 

1 to 5 online types. 
 

 

Which Types? 
 

When you have chosen the number of types to include, PostSearch™ leaves open that number of fields in the dialog 

box to let you specify the types you want.  You may specify record types up to ten characters long, e.g. 9, TI, 3,AB, 

6,KWIC. 
 

Files Created and Preserved 
 

The files created and preserved when filtering specified onine types to one file are the same as when filtering all 

online types to one file. 

 

2.6 Filter Specified Online Types to Separate Files 
 
Menu Steps 
 

1. Choose the Filter menu 

2. Choose the DIALOG system 

3. Choose  the Specified Types to Separate Files command 

4. Specify a captured search file to filter 

5. Choose the number of types to specify from 1 to 5 

6. Specify the online types and separate files 



 

Filter-Menu:  Choose DIALOG 
 

PostSearch™ lets you filter search files captured while searching a number of different systems.  Differences in the 

systems require different filters tailored to each system.  PostSearch™ includes filters for searches of DIALOG, 

Data-Star, Dow Jones News/ Retrieval //TEXT, STN, Ovid and National Library of Medicine.  For filtering to work 

properly, you must match the filter to the system. 
 

Select DIALOG Filtering Option 
 

The filters for DIALOG searches provide additional flexibility.  You can filter all online types to one file, up to five 

specified types to one file, up to five specified types to separate files, or all offline prints delivered via DIALMAIL 

to one file. 
 

Choosing this filtering option, Specified Types to Separate Files, lets you include only the online types you choose 

and divide them into separate files, one file for each type.  You may choose this filtering option from the menus or if 

you will be using the DIALOG filter command button, from the option buttons: 
 

 

Open Dialog Box 
 

After choosing this DIALOG filtering option, the Open dialog box opens.  You may type the name of a file in the 

text box within the dialog box if you know it.  Otherwise you can use the file, directory and drive list boxes to locate 

and choose the file you want to filter. 
 

How Many Types? 
 

When you have specified the captured search file to be filtered, PostSearch™ opens a dialog box to let you choose 

the number of online types to include in the output file, and then specify the types.  You may choose to include from 

1 to 5 online types. 
 

 

Which Types and Files? 
 

When you have chosen the number of types to include, PostSearch™ leaves open that number of fields in the dialog 

box to let you specify the types you want and the names of the separate files for each type.  You may specify record 

types up to ten characters long, e.g. 9, TI, 3,AB, 6,KWIC.  Specify just the base file name (up to eight characters) for 

each .PRO file.  PostSearch™ automatically gives each output file the required .PRO extension. 
 

Files Created and Preserved 



 

The files created and preserved using this filtering option are similar to those when using other DIALOG options, 

except that there are as many .PRO and .NDX files as types specified.  (If no records of a specified type occur in the 

search log, no .PRO or .NDX file will be created for that type.) 

 

2.7  Filter DIALMAILed Offline Prints 
 
Menu Steps 
 

1. Choose the Filter menu 

2. Choose the DIALOG system 

3. Choose  the DIALMAILed Prints to One File command 

4. Specify a DIALMAIL session file to filter 
 

Filter Menu:  Choose DIALOG 

 

PostSearch™ lets you filter search files captured while searching a number of different systems.  Differences in the 

systems require different filters tailored to each system.  PostSearch™ includes filters for searches of DIALOG, 

Data-Star, Dow Jones News/ Retrieval //TEXT, STN, Ovid and National Library of Medicine.  For filtering to work 

properly, you must match the filter to the system. 
 

Select DIALOG Filtering Option 
 

The filters for DIALOG searches provide additional flexibility.  You can filter all online types to one file, up to five 

specified types to one file, up to five specified types to separate files, or all offline prints delivered via DIALMAIL 

to one file. 
 

Choosing to filter DIALMAILed offline prints causes PostSearch™ to include all records delivered as offline prints 

via DIALMAIL captured during a DIALMAIL session to be included in a single output file.  You may choose the 

this filtering option from the menus or if you will be using the DIALOG filter command button, from the option 

buttons: 
 

 

IMPORTANT: If your search file captured only online types and no offline prints delivered via DIALMAIL, this 

option won’t do much for you. 
 

Open Dialog Box 
 

After choosing a DIALOG filtering option, the Open dialog box opens.  You may type the name of a file in the text 

box within the dialog box if you know it.  Otherwise you can use the file, directory and drive list boxes to locate and 

choose the file you want to filter. 
 

Files Created and Preserved 
 

The files created and preserved when filtering DIALMAILed records to one file are the same as when filtering all 

online types to one file 

 



2.8  Files, Sets and Costs Information 

 
When using any of the DIALOG filters, PostSearch™ attempts to save information about the search to a separate 

file.  The information includes: 
 

• files information DIALOG displays when you use DIALOG's Begin command. 

• sets information DIALOG displays when you use DIALOG's Display Sets command or DIALOG's Select 

[term one] and [term two] command. 

• costs information DIALOG displays when you change files or log off. 
 

PostSearch™ saves this information to a file with the same base name as the search file being filtered plus a .FSC 

extension. 

 

2.9  Ad Hoc Filtering 

 
The ad hoc filter lets you clean up and index files from sources not directly supported by any of the other filters.  

This can be beneficial even for data where clean-up is not a major issue because the indexing will allow you to use 

PostSearch™ features such as sifting. 

 

In ad hoc filtering, before specifying the input file, it is necessary to specify record markers.  This might be done in 

either of two modes:  a single, beginning marker; or a begining marker and an ending marker. 

 

 

The markers must exist in the input file, must be on lines by themselves with nothing else on the lines, and must be 

flush to the left. 

 

Depending upon the source of the data, something might already exist in a file which can be used as markers.  If not, 

it will be necessary for you to insert the markers.  For example, you might place -text- on the line before each record 

and -end- on the line after.  It is well to choose markers that are simple and not likely to already exist in the file (to 

avoid filtering ambiguity). 

 

3.  Sift 
 

3.1  Reasons for Sifter 
 
After Clean-up, Editing 
 

Once a search is cleaned up, often times post-processing is not finished.  There might be a need for further editing.  

The records might need to be evaluated for relevance, date, authority, and other factors.  Irrelevant or less weighty 

records are deleted; weighty ones are moved to the top of the file.  Usually this has been done in a word processor or 

text editor. 



 

Drawbacks of Word Processors 
 

When you press PgDn in a word processor, from 24 to 50 lines of text move, depending on your video mode.  This 

might or might not bring you to a new record, and when it does, the record can begin at any vertical position on your 

screen.  Your eyes have to pick it out at a different place every time.  This can be time-consuming, tedious and prone 

to error. 
 

Each time you decide to keep or  move a record, you have to use highlighting, cursor movements, block operations, 

cut-and-paste and other manipulations.  More time, more tedium, more error. 
 

What “Sifting” Means 
 

Sifting means to edit a filtered search on a record-centered basis. 
 

The sifter is designed to eliminate those word processing manipulations and replace them with single commands for 

speed, ease of use, tedium reduction and error reduction.  Though a cleaned up record file is sheer text, not a 

database, and though the records are of variable length, the sifter’s commands can act at once on whole records as 

discrete units.  You can: 
 

• view records, navigating through them record-by-record (rather than line-by-line or page-by-page as in a 

word processor) with the commands Next, Previous, First, Last and Jump (directly to a record by number).  

Each time you use one of these commands, the new record appears as a whole, always in the same position . 

 

• write chosen records to one or many new files with the commands Keep and Keep Express, with no need to 

highlight, cut-and-paste, perform block operations or otherwise manipulate the text constituting a record. 
 

• reorder records with the Order command, specifying the currently displayed record’s new order by simply 

typing a number.  When you’ve got them the way you want them, you can write them in their new order to a 

new file with the Write Order command. 
 

These commands are available: 
 

• by keyboard, as single key or key combinations 

• by menu, using the keyboard or mouse 

• by command buttons, by clicking the buttons with the mouse 

 
Menu Steps 

 
1. Choose the After Filtering menu 

2. Choose the Sift command 

3. Specify a filtered record file with a .PRO file name extension or its associated index file with a .NDX file 

name extension 

4. Browse individual records and navigate between records 

5. Write records you select to new files, using Keep and Keep Express commands 

6. Reorder records, using Order and Write Order commands 
 

Command Button 
 

You may also activate sifting more directly by clicking the Sift command button. 
 

3.2  Working with Indexes 
 
The Need for Indexes 
 

The sifter works on a record-centered basis.  Its core commands act at once on whole records as discrete units, 

despite their variable lengths. To allow this, it needs an index of the records.  The index enables the sifter to: 



 

• support navigation through the filtered record file on a record-by-record basis 
 

• support the Keep and Keep Express commands which write records as whole, discrete units to new files 
 

• support the Order and Write Order commands which let you reorder records 
 

Ways to Get Indexes 
 

There are several ways to get an index synchronized to a particular filtered record file: 
 

• The filters create index files for the sifter on-the-fly while filtering. 
 

• The sifter can scan the lines in the filtered record file and index the records from scratch. 
 

• When the sifter builds an index from scratch, it automatically saves it to a disk file. 
 

• While sifting, the current index can be written to disk with the Save Index command on the File menu.  

Indexes saved this way are unique in also recording your place in the file so you can begin sifting again later 

at the same record which was being displayed when the index was saved. 
 

Open Dialog Box 
 

When you choose the Sift command, the Open dialog box opens.  You must specify a .PRO or .NDX file.  You will 

choose a .NDX file to load an index from disk or a .PRO file to let the sifter build an index from scratch.  The sifter 

requires a .PRO file as the primary input file as a precaution that the file likely is one of filtered records.  This is 

likely because the filters give that extension to filtered record files.  If you choose a .PRO file, it is the only input file 

and hence the primary input file.  If you choose a .NDX file, PostSearch™ loads the index from disk, then identifies 

the associated .PRO file as the primary input file. 
 

You may type the name of a file in the text box within the dialog box if you know it.  Otherwise you can use the file, 

directory and drive list boxes to locate and choose the file you want to filter.  The file list box is configured to 

display .PRO and .NDX files by default since you must specify a file with one or the other of those two extensions. 
 

Loading Indexes from Disk Files 
 

Indexes are written to disk files because loading them from disk is much faster than building them from scratch.  

The ability to build indexes from scratch in the sifter is included because you might join, split or otherwise change 

filtered record files, in which case you would not have an index file synchronized with your changed .PRO file. 
 

The index file for a particular .PRO file has the same base name as the filtered record file plus a .NDX extension.  

For example, if the filtered record file is SEARCH.PRO, the index file is SEARCH.NDX. 
 

When you want to sift a record file which already has an index file, choose the .NDX file associated with the .PRO 

file at the Open dialog box. 
 

Please understand that if any alterations have been made to either the record file or the index file, the index will be 

out of synch with the record file.  If this happens, you will need to let the sifter re-index the record file from scratch, 

otherwise you could experience unpredictable results. 
 

Building Indexes from Scratch 
 

To let the sifter build an index from scratch, choose the .PRO file at the Open dialog box. 
 

In case the file is long, to let you know what is happening, the program displays a line odometer and then a record 

odometer. 
 



 

It also displays a progress meter which shows the percentage of completion based on the number of lines in the file, 

first showing progress in scanning the lines and then in indexing the records.  When indexing is complete, the 

program automatically activates the sift viewer and displays the first record. 

 

Indexing Capacity 
 

In previous versions of PostSearch™, indexing was limited to 2000 records.  Since the release of version 2.2, that 

limitation has been removed.  You may now sift a virtually unlimited number of records.  Index files from prior 

versions are no longer compatible with the new indexing method.  If you need to sift a file filtered with a previous 

version of PostSearch™, let the sifter build a new index from scratch in the new format.  To do this, specify the 

.PRO file instead of the old .NDX file in the Open dialog box. 

 

3.3  Viewing Records 
 
When the sifter has either loaded an index from disk file or built one from scratch, it activates the sift viewer and 

displays the first record (or if the .NDX file is one saved during a pervious sifting session, the record which was 

being displayed when the index was saved). 
 

Orientation Lines 
 

The sift viewer displays orientation lines near the top of the screen.  These lines remind you 
 

• which .PRO file currently is being sifted 

• the name of the "keep" file to which the last "kept" record was written, if any 

• the number of indexed records in the .PRO file 

• which record in index order currently is being displayed 

• the name of the file to which the currently displayed record has been marked for keeping, if any 
 

The record number indicated is according to the index.  If the numbering of the labels in the file is not in order, at 

times a record label will vary from the record number in the orientation lines. 
 

The Current Keep File reminder is helpful especially when using the Keep Express command discussed later, so you 

can decide whether to use that command or the Keep command.  Keep lets you change the name of the file to which 

the record will be written while Keep Express automatically writes the record to the same file to which the last 

"kept" record was written. 
 

Record Browsing 
 

Within a record, certain browsing keys are active, including Down Arrow, Up Arrow, PgDn, PgUp, Ctrl-PgDn, 

Ctrl-PgUp, Home and End.  The record can also be browsed using the mouse on the scroll bar. 
 

Record Navigation 
 

The record file can be navigated one a record-by-record basis with the Next, Previous, First, Last and Jump 

commands from the Record menu.  The Jump command lets you navigate directly to a record by number.  These 

commands are available by keyboard shortcuts using N, P, F, L and J, and by command buttons. 
 

 



Initially Displayed Record 
 

The first time you sift a file, the initially displayed record will be the first one.  In case you have to stop sifting 

before you’ve viewed all the records, PostSearch™ will remember where you were.  When you return to sifting the 

same file, the initially displayed record will be the one which was being displayed when you quit sifting it before, to 

allow you to easily continue where you left off. 

 

3.4  Keeping Records 
 
Keep 
 

The Keep command lets you mark the currently displayed record to be written to a file you specify.  This command 

is available on the Keep menu, keyboard shortcut using the K key, and by the Keep command button. 
 

When you use Keep, PostSearch™ opens a dialog box asking you the name of the file where you want to keep the 

record.  If you give just a file name, it will be written in the current directory.  You must give a full drive and path to 

write the record to a file in a different subdirectory or on a different drive. 
 

When a record is kept, the sifter automatically advances to the next record in the file being sifted.  In case you wish 

to look back to a record to see if it has been marked for keeping or to see the name of the file where it will be kept 

to, the Kept To: indicator provides this information.  If the indicator is blank, the record has not been marked for 

keeping. 
 

Keep Express 
 

The Keep Express command lets you mark the currently displayed record to be written to the same file as the last 

kept record without having to again specify that file.  This command is available on the Keep menu, by keyboard 

shortcut using the Alt-K key combination, and by the Keep Express command button. 
 

When you use Keep Express, the currently displayed record is marked to be written to the file indicated in the 

Current Keep File reminder in the orientation lines.  The intervening step of specifying the file to which you wish to 

write the record is skipped. 
 

Unkeep 
 

You might change your mind about keeping a particular record. PostSearch™ allows you to do that.  Navigate back 

to the record and choose the Unkeep command.  This command is available on the Keep menu, by keyboard shortcut 

using the Ctrl-U key combination, and by the Unkeep command button. 
 

When you use Unkeep, the Kept To indicator will be blanked confirming that the record is no longer marked for keeping 
 

Write Kept 
 

In prior versions of PostSearch™, the Keep and Keep Express commands immediately wrote the currently displayed 

record to the keep file.  To implement the Unkeep command, Keep and Keep Express no longer behave that way.  

Instead they merely mark the records to be kept so that if you change your mind, you can use Unkeep to remove the 

mark.  To write the records marked for keeping, choose the Write Kept command.  The Write Kept command is 

available on the Keep menu, by keyboard shortcut using the Ctrl-K key combination, and by the Write Kept 

command button. 
 
 

In case you mark some records for keeping and then exit the sifter without remembering to use Write Kept, 

PostSearch™ catches the oversight and prompts you with a dialog box asking if you want to write the records 

marked for keeping. 
 

Keep List 
 

The Keep List command will display a list box showing the numbers of all records currently marked for keeping. 



 

The Keep List command is a toggle.  Executing it while the list is not displayed causes it to appear.  Executing it 

while the list is displayed causes it to disappear. 

 

The numbers are according to input (.PRO, not .ORD) order.  The list can display four columns of numbers.  When 

more numbers are in the list than will fit in the display, a horizontal scroll bar automatically appears at the bottom of 

the box allowing you to scroll the display to view other columns. 

 

3.5  Reordering Records 
 
Why Use Reordering 
 

You might want to reorder records for various reasons:  to place the most relevant records first; to place the most 

important records first; to place more recent records first; to group references by author, etc. 
 

What Reordering Does 
 

Reordering lets you move the currently displayed record to a new position.  At first, PostSearch™ merely makes 

"mental notes" of your position changes.  When ready, you can have PostSearch™ use these "mental notes" to write 

a new file of the records in their new order.  The input file is not altered. 
 

Order Command 
 

To change the position of the currently displayed record, choose the Order command from the Order menu, by 

keyboard shortcut using the O key, and by the Order command button. 
 

This opens a box letting you tell PostSearch™ the new position for the record.  The valid range of positions is from 1 

to the total number of indexed records in the file.  PostSearch™ indicates the range in the box.  In the input field, 

type the number for the position you choose. 
 

When you specify a new order number, PostSearch™ makes a "mental note" to insert the currently displayed record 

at that position and move the record which was at that position and all of the following records down one position.  

For example, if you reorder record 34 to record 4, record 34 will become record 4, record 4 will become record 5, 

record 5 will become record 6, etc. 
 

rite Order Command 
 

While using the Order command, no changes are made to any disk file and no new file is created.  PostSearch™ 

merely makes "mental notes" of your changes.  To create a new file of the records in their new order, choose the 

Write Order command from the Order menu.  This command is also available by keyboard shortcut with the W key 

and by the Write Order command button. 
 

Write Order uses the "mental notes" to create a new file of the records in their new order.  The new file will have the 

same base file name as the input file plus a .ORD extension. 
 

If you make changes with the Order command and forget to save the records in their new order with the Write 

Order command before exiting the sifter, PostSearch™ detects the oversight and opens a dialog box asking whether 

you wish to write the .ORD file. 
 

Using Write Order does not end the sifting session.  You can continue sifting, keeping and reordering if you wish, 

and can use the Write Order command again.  If you use the Write Order command again, the .ORD file will be 

overwritten according to the current state of the "mental notes." 
 

Switching Views (Order Toggle) 
 

You can switch between viewing the records in their order in the input file and their order as they would be written 

to the .ORD file according to the current status of the "mental notes."  Choose the Order Toggle command from the 



Order menu, by keyboard shortcut with the Ctrl-O key combination, or by the Order Toggle command button. 
 

This switches the sifter to ".ORD View."  As a toggle, if you use it again, the sifter switches back to “.PRO View”.  

When in ".ORD View," PostSearch™ displays an indicator near the upper right corner of the screen that it is in this 

mode. 
 

When you switch views, PostSearch™ automatically goes to the position in the other order where the same record is 

located.  You won't see the record change.  This lets you consider the same record in the other context with the 

record navigation commands.  Depending on how you've reordered records, you might see the orientation lines 

change. 

 

For example, if you are viewing Record - 3 in normal view, and have moved it to position 1 with the Order 

command, on choosing the Order Toggle command, Record - 3 will remain on your screen, the view indicator will 

indicate that you've switched to ".ORD View," and the orientation lines will show that in that view, you're looking at 

record 1.  The record label in the data is not changed (when you're all done and have written the .ORD file, you can 

use the Renumber command from the After Filtering menu if you like), so the label no longer indicates the record's 

position in the .ORD file that would be written with the Write Order command.  The orientation line indicates the 

currently displayed record's position as reordered.  If you switch views back to .PRO view, Record - 3 again remains 

on your screen, the view indicator changes back to indicating “.PRO View”, and the orientation lines change to 

show the position of Record - 3 in “.PRO View”. 

 

4. Query by Form 
 
Menu Steps 
 

1. Choose the After Filtering menu 

2. Choose the Query by Form command 

3. Specify a filtered record file with a .PRO file name extension or its associated index file with a .NDX file 

name extension 

4. Fill in the query form 

5. Choose the Submit Query command 

6. Specify an output file name 
 

Command Button 
 

You may also activate QBF more directly by clicking the Query command button. 
 

What Querying Does 
 

Querying allows you to apply query-by-form (QBF) to a filtered record file.  In QBF you place key words on a 

search request form.  Records selected by the query are written to a new file.  The form implements Boolean 

operators, nesting and truncation. 
 

Using Indexes 

 

QBF uses record indexes like the sifter does.  When you choose the Query command from the After Filtering menu, 

the Open dialog box opens.  Follow the same procedure as if you were sifting, by choosing either a .PRO or .NDX 

file. 

 

QBF Query Form 

 

When the index is loaded from disk file or built from scratch, PostSearch™ displays a form on which you can place 

key words. 
 



 

The form provides three rows of three blanks each.  Each row represents a nest of search terms.  Within each nest 

the terms will be related to each other by the OR operator.  The second nest will be related to the other two nests by 

the AND operator and the third nest will be related to the other two nests by the NOT operator.  Right truncation is 

supported with the asterisk (*).  Specifying "glaci*", for example, would hit on glacier, glacial, etc.  Phrases with 

spaces, like "glacial lake", are not supported. 
 

A search term is required in the first blank of the first nest.  All other blanks are optional; no key word need be filled 

into them. To bypass a blank, simply press TAB without typing a key word.  The cursor will move to the next field 

or nest, or if you have filled in all the blanks you want, choose the Submit Query command. 
 

Query File 
 

When you choose the Submit Query command, PostSearch™ opens the Save As dialog box asking you to specify 

the name of the output file where the hit records will be written.  No particular extension is required and none is 

given automatically, but you should avoid using the input file name or extensions used by PostSearch™ for special 

purposes, .PRO, .NDX, .FSC, .ORD, .FMT, .BRK, .RNK, .TBL, .SRT, and .DIC, to avoid overwriting a file you 

mean to preserve. 
 

Searching and Writing 

 

When you have specified a select file name, PostSearch™ automatically begins searching the filtered record file for 

records which satisfy your search request.  While searching, PostSearch™ displays a progress meter, line and record 

odometers for the file being queried, and line and record odometers for the query file where hit records are written. 

 

5. Rank 
 
Menu Steps 

 

1. Choose the After Filtering menu 

2. Choose the Rank command 

3. Specify a record file 

4. Fill in the rank form 

5. Choose the Begin command 
 

Command Button 

 

You may also activate ranking more directly by clicking the Rank command button. 
 

What is a Record File? 
 

Once you have filtered a captured search file, you have a record file with a .PRO extension.  You might have reason 

to sift, edit, copy, join, split, rename or query these record files.  Any of the resulting files containing numbered 

record labels in the form 
 



Record - 1 

 

are record files. 
 

What Ranking Does 
 

Ranking reorders records by weighted frequency of terms.  The Rank command lets you specify up to six terms and 

assign a weight from 1 to 9 to each term.  PostSearch™ will then read the records, note occurrences of the weighted 

terms, accumulate a total weight for each record, and write a new file of the records ranked in the order of total 

weight.  Right truncation is supported with the asterisk (*). 

 

 

Rank File and Rank Table 
 

PostSearch™ automatically names the ranked file with the same base name as the record file plus a .RNK extension.  

For example, if the record file is SEARCH.PRO, PostSearch™ will name the ranked file SEARCH.RNK.  

PostSearch™ preserves the record file without altering it. 
 

PostSearch™ also creates a rank table file to document the ranking.  The rank table identifies the ranked file, the date 

and time of ranking, the terms specified, the weights assigned, the rank order of each record, the input order of each 

record and the total weight of each record.  Below is an illustrative portion of a rank table file: 
 

Rank Table for C:\POSTWIN\PSDEMO.RNK 

6/8/95   6:23:54 PM 

 

Wts   Terms 

---   ----- 

 1    cost* 

 3    online 

 3    on-line 

 6    cd-rom 

 

Rank    Input   Total 

Order   Order   Weight 

-----   -----   ------ 

 1       9       32 

 2       6       31 

 3       37      25 

 4       16      24 

 5       12      20 



 6       19      19 

 7       24      19 

 8       15      17 

 9       13      16 

 10      33      14 

 

6. Sort  
 
Menu Steps 

 

1. Choose the After Filtering menu 

2. Choose the Sort command 

3. Specify a record file with field tags 

4. Fill in the sort form 

5. Choose the Begin command 
 

Command Button 

 

You may also activate sorting more directly by clicking the Sort command button. 
 

What is a Record File? 
 

Once you have filtered a captured search file, you have a record file with a .PRO extension. You might have reason 

to sift, edit, copy, join, split, rename or query these record files.  Any of the resulting files containing numbered 

record labels in the form 
 

Record - 1 

 

are record files. 
 

What are Tags? 
 

Field tags are the letters in the left few columns which abbreviate the field names.  Some systems include tags by 

default.  Others, like Dialog, provide TAGed output in certain online types or when the TAG option is added to a 

TYPE command. 
 

The following record fragments illustrate tags on different systems: 
 

AN   89:447670  SCISEARCH 

GA   The Genuine Article (R) Number: AL498 

TI   APPLICATION SYSTEM-400 PERFORMANCE-CHARACTERISTICS 

AU   CLARK B E (Reprint); CORRIGAN M J 

CS   IBM CORP, APPLICAT BUSINESS SYST, HIGHWAY 52 & NW 

     37TH ST, ROCHESTER, MN, 55901 (Reprint) 

CYA  USA 

SO   IBM SYSTEMS JOURNAL, (1989) Vol. 28, No. 3, pp. 407-423.  

DT   Article; Journal 

FS   ENGI 

LA   ENGLISH 

REC  Reference Count: 7 

 

 
AN- <DIALOG MEDLINE FILE> 08854428| 

AN- <NLM> 94169428| 

TI- Orocaecal transit, bacterial overgrowth and hydrogen 

    production in diabetes mellitus.| 

AU- Sarno S^Erasmas LP^Haslbeck M^Holzl R| 

CS- Klinische Psychologie, Universitat Mannheim, III 

    Medizinische Abteilung, Krankenhaus Munchen 

    Schwabing, Germany.| 

SO- <JN> Ital J Gastroenterol| 

CP- ITALY| 

SO- <PY> Nov-Dec 1993| 

SO- <VO> 25 (9) p490-6| 



SN- 0392-0623| 

JC- A9I| 

LA- ENGLISH| 

DT- JOURNAL ARTICLE| 

JA- 9406| 

SF- INDEX MEDICUS| 

 

 
UI  - 93199072 

AU  - Bayes J 

TI  - Administration of metered dose inhalers during 

      anesthesia via CO2 monitor port [letter] 

MH  - Anesthesiology/*INSTRUMENTATION 

MH  - Bronchodilator Agents/*ADMINISTRATION & DOSAGE 

MH  - Human 

MH  - *Nebulizers and Vaporizers 

PT  - LETTER 

LA  - Eng 

SO  - Anesth Analg 1993 Mar;76(3):665 

 

The following record is not tagged: 
 

DIALOG(R)File   1:ERIC 

(c) format only 1994 Dialog Info.Svcs. All rts. reserv. 

 

EJ421662   IR522582 

  CD-ROM vs. Online: Implications for Management from the Cost Side. 

  Erkkila, John E. 

  Canadian Library Journal; v47 n6 p421-28 Dec 1990 

  Report No.: ISSN-0008-4352 

  Language: English 

  Document  Type:  JOURNAL  ARTICLE (080); POSITION PAPER (120); EVALUATIVE 

REPORT (142) 

  Journal Announcement: CIJJUN91 

  Discussion of the cost effectiveness of searching online versus searching on  CD-ROM highlights an 

example that compares costs for searching the ERIC database.  Fixed  costs  and  variable costs are 

described, labor costs are examined, implications for management are considered, and the effect of the 

number of databases and workstations is discussed. (32 references) (LRW) 

  Descriptors:  Academic  Libraries; Budgeting; Comparative Analysis; *Cost Effectiveness;  Costs;  

Databases;  Futures (of Society); Higher Education; Library   Administration;   *Library   Expenditures;  

Library  Instruction; Microcomputers;  *Online  Searching;  *Online Systems; *Optical Data Disks; *Search 

Strategies; Users (Information) 

  Identifiers: *ERIC; Workstations 

 

What Sorting Does 
 

Sorting alphabetizes records on a field.  For example, you can alphabetize records by author by specifying the AU- 

field. 

 

 

For best results, include all characters, including spaces and dashes, through the column just to the left of the field 

contents.  For example, in records tagged as follows: 
 

AU- Sarno S^Erasmas LP^Haslbeck M^Holzl R| 

 

specify, for example,  “AU- ”.  In records tagged as follows: 
 

AU  - Bayes J 



 

specify, for example, “AU  - ”. 
 

Files Created and Preserved 
 

PostSearch™ automatically names the sorted file with the same base name as the record file plus a .SRT extension.  

For example, if the record file is SEARCH.PRO, PostSearch™ will name the sorted record file SEARCH.SRT.  

PostSearch™ preserves the record file without altering it. 

 

7.  Diction 

 
Menu Steps 

 

1. Choose the After Filtering menu 

2. Choose the Diction command 

3. Specify an input file 
 

Command Button 

 

You may also click on the Diction command button. 
 

What Diction Does 
 

The Diction command creates a list of all words in a file, except those in an omit list.  The diction list is sorted from 

most frequent to least, and subsorted alphabetically.  Below is an illustrative portion of a diction list file: 

 
Diction List for C:\POSTWIN\PSDEMO.PRO 

6/8/95   7:21:13 PM 

 

Unique Words:  963 

 

 87     dialog 

 67     journal 

 58     online 

 50     information 

 49     library 

 48     cost 

 42     eric 

 42     microcomputers 

 40     databases 

 37     1994 

 37     file 

 37     format 

 37     info 

 37     reserv 

 37     rts 

 37     svcs 

 34     document 

 34     systems 

 33     article 

 33     data 

 33     effectiveness 

 33     language 

 32     080 

 32     announcement 

 32     computer 

 32     descriptors 

 32     english 

 32     type 

 29     database 

 28     identifiers 

 27     libraries 

 25     user 

 24     available 

 24     searching 

 23     cd-rom 

 23     optical 

 23     software 

 22     project 



 

Omit List 
 

PostSearch™ comes with a default omit list in a file called OMIT.LST in the installation directory.  This is a pure 

text file with one omit word on each line.  You can edit the file to customize the omit list to suit your purposes.  

Make sure, however, to save the edited file as pure text without any word processor embedded formatting codes. 
 

The following table documents the contents of the default omit list, reformatting it into columns to fit the display of 

the help system: 
 

#          did         may         the 

$          do          more        their 

%          during      most        them 

0          e           much        then 

1          each        my          there 

2          end         n           these 

3          f           no          they 

4          for         not         this 

5          from        now         those 

6          g           o           through 

7          h           of          to 

8          had         on          two 

9          has         one         u 

a          have        only        under 

about      having      or          until 

after      he          other       up 

all        her         our         use 

also       him         out         v 

among      his         over        very 

an         how         own         w 

and        however     p           was 

another    i           pp          way 

any        if          q           we 

are        in          r           were 

as         into        s           what 

at         is          said        when 

b          it          same        where 

be         it's        says        whether 

because    its         see         which 

been       j           she         while 

before     just        should      who 

being      k           since       will 

both       l           so          with 

but        last        some        would 

by         like        still       x 

c          m           such        y 

can        made        t           you 

could      make        than        your 

d          many        that        z 

 

Files Created and Preserved 
 

PostSearch™ automatically names the diction file with the same base name as the input file plus a .DIC extension.  

For example, if the input file is SEARCH.PRO, PostSearch™ will name the diction file SEARCH.DIC.  

PostSearch™ preserves the input file without altering it. 

 

8.  Renumber Record Labels 
 
Menu Steps 
 

1. Choose the After Filtering menu 

2. Choose the Renumber command 

3. Specify a record file 

4. Specify a name for the output file 
 



Command Button 
 

You may also activate renumbering more directly by clicking the Renumber command button. 
 

What is a Record File? 
 

Once you have filtered a captured search file, you have a record file with a .PRO extension.  You might have reason 

to sift, edit, copy, combine or rename these record files, or select records by key words.  Any of these files 

containing numbered record labels in the form 
 

Record - 1 

 

are record files. 
 

Why Renumber? 
 

If you sift, keep, reorder, edit, a record file, or select records by key words, the resulting file might contain records 

whose labels no longer are in numerical order.  The renumbering facility lets you automatically renumber the labels 

without having to do so manually in a text editor or word processor.  For example, you might have a file like this: 
 

Record - 7 

 

record content 

 

Record - 22 

 

record content 

 

Record - 98 

 

record content 

 

What Renumbering Does 
 

The renumbering facility reads a record file, finds the numbered record labels, and automatically renumbers the 

labels in numerical order within the file.  Continuing the example above, the renumbering facility would produce a 

renumbered file like this: 
 

Record - 1 

 

record content 

 

Record - 2 

 

record content 

 

Record - 3 

 

record content 

 

Files Created and Preserved 
 

When you choose a record file in the Open dialog box, PostSearch™ opens the Save As dialog box.  Type a name 

for the output file.  PostSearch™ does not automatically name the output file.  You should avoid using the extension 

of the original search log or extensions used by PostSearch™ for special purposes, .PRO, .NDX, .FSC, .ORD, .RNK, 

.TBL, .SRT, .DIC, .FMT or .BRK, to avoid overwriting a file you mean to preserve.  The input file is preserved 

unaltered. 

 



9.  Delete Record Labels 
 
Menu Steps 
 

1. Choose the After Filtering menu 

2. Choose the Label Changes sub-menu 

3. Choose the Delete command 

4. Specify a record file 

5. Specify a name for the output file 
 

Command Button 
 

You may also activate deleting more directly by clicking the Delete command button. 
 

What is a Record File? 
 

Once you have filtered a captured search file, you have a record file with a .PRO extension. You might have reason 

to sift, edit, copy, join, split, rename or query these record files.  Any of the resulting files containing numbered 

record labels in the form 
 

Record - 1 

 

are record files. 
 

What Deleting Labels Does 
 

Deleting record labels does just one thing:  produce a new output file in which the data is entirely unaltered except 

that the record labels are gone. 

 

10.  Replace Record Labels 
 
Menu Steps 
 

1. Choose the After Filtering menu 

2. Choose the Label Changes sub-menu 

3. Choose the Replace command 

4. Choose a replacement option 

5. (single replacement, double replacement, surround replacement) 

6. Specify a name for the output file 
 

Command Button 
 

You may also activate replacing more directly by clicking the Replace command button. 
 

What is a Record File? 
 

Once you have filtered a captured search file, you have a record file with a .PRO extension. You might have reason 

to sift, edit, copy, join, split, rename or query these record files.  Any of the resulting files containing numbered 

record labels in the form 
 

Record - 1 

 

are record files. 
 

What Replacement Does 
 



If you choose single replacement, the labels provided by PostSearch™ filtering in the form Record -1 will be 

removed and replaced by what you type in a text box to take their place. 
 

 

If you choose double replacement, the labels will be removed and in their place will be beginning record markers 

and ending record markers.  For example, some searchers have a use to mark the beginning of each record with “- 

text-” and the end of each record with “-end -”   
 

 

The output would look like this: 
 

- text - 

 

DIALOG(R)File   1:ERIC 

(c) format only 1994 Dialog Info.Svcs. All rts. reserv. 

 

EJ421662   IR522582 

  CD-ROM vs. Online: Implications for Management from the Cost Side. 

  Erkkila, John E. 

  Canadian Library Journal; v47 n6 p421-28 Dec 1990 

 

- end - 

 

- text - 

 

DIALOG(R)File   1:ERIC 

(c) format only 1995 Knight-Ridder Info. All rts. reserv. 

 

EJ426056   IR522936 

  The Seven Stages of an Online Search--Part I. 

  Quint, Barbara 

  Online; v15 n3 p13-18 May 1991 

 

- end - 



 

Surround replacement is like double replacement except that the PostSearch™ record labels remain.  Continuing the 

“- text -” and “- end -” example, the output would look llike this. 
 

- text - 

Record - 1 

 

DIALOG(R)File   1:ERIC 

(c) format only 1994 Dialog Info.Svcs. All rts. reserv. 

 

EJ421662   IR522582 

  CD-ROM vs. Online: Implications for Management from the Cost Side. 

  Erkkila, John E. 

  Canadian Library Journal; v47 n6 p421-28 Dec 1990 

 

- end 

 

- text 

Record - 2 

 

DIALOG(R)File   1:ERIC 

(c) format only 1995 Knight-Ridder Info. All rts. reserv. 

 

EJ426056   IR522936 

  The Seven Stages of an Online Search--Part I. 

  Quint, Barbara 

  Online; v15 n3 p13-18 May 1991 

 

- end - 

 

11.   Insert Page Breaks 
 
Menu Steps 
 

1. Choose the After Filtering menu 

2. Choose the Format command 

3. Choose the Page Breaks command 

4. Specify a record file 

5. Specify the interval by number of records between breaks 
 

Command Button 
 

You may also activate page breaking more directly by clicking the Page command button. 
 

Inserting Page Breaks 
 

PostSearch™ lets you automate the insertion of page breaks.  Page breaks between records will be hard-coded at 

intervals you specify.  This feature is dependent on the presence of record labels in the format produced by 

PostSearch's filter.  You would want to use this feature only with filtered records. 
 

The page breaker uses the base file name of the record file plus .BRK for the output file.  Using .BRK for the input 

file name will generate the error of both files having the same name. 
 

You must specify the interval at which logical page breaks will be inserted.  The range of permissible intervals is 1 

to 99.  One handy use of this feature is to print as many records as will fit on each page and insure that the next 

record begins printing on a new page.  Using this feature is much faster, less tedious and less prone to error than 

manually inserting page breaks with a word processor.  PostSearch™ cannot anticipate for you, however, how many 

records will fit since this varies with word processors, printers, fonts, margin settings, etc.  You'll need to know the 

number, and then PostSearch™ can automate page breaking for you. 
 



If you want every record to begin printing on a new page, as you might with full text records, specify 1.  If any 

record is more than one page long, your word processor will be able to print it from page to page, and then begin the 

next record on a new page. 

 

12.   Remove Hard Carriage Returns 
   (In DIALOG TAGed Records) 
 
Menu Steps 
 

1. Choose the After Filtering menu 

2. Choose the Format command 

3. Choose the TAGed Records command 

4. Specify a record file containing DIALOG TAGed records 
 

Command Button 
 

You may also activate reformatting more directly by clicking the TAGed command button. 
 

Why Reformat? 
 

Captured files usually have hard carriage returns at the end of each line even if the lines are not the ends of 

paragraphs or fields.  This makes formatting in word processors a sizable chore.  If your search log has TAGed 

records, which DIALOG provides in Type 4 or when you add TAG to the end of your TYPE command, 

PostSearch™ can remove the hard carriage returns within fields.  See Susan N. Bjorner, "Of Wits and Magic and 

Micro Worlds:  Removing Unwanted Carriage Returns from Search Output," Online, p. 85 (January 1992). 
 

What is a Record File? 
 

Once you have filtered a captured search file, you have a record file with a .PRO extension.  You might have reason 

to sift, edit, copy, combine or rename these record files, or select records by key words.  Any of these files 

containing numbered record labels in the form 
 

Record - 1 

 

is a record file. 
 

Files Created and Preserved 
 

At the Open dialog box choose a file with some extension other than .FMT.  The reformatter uses the base file name 

of the input file plus a .FMT extension for the output file.  When you have chosen the input file, PostSearch™ opens 

a dialog box which tells you it is reformatting.  It reports its progress, showing the line number and record number 

being processed.  It displays a meter showing the percentage of completion based on the number of lines in the file.  

PostSearch™ preserves the record file without altering it. 

 

13.  Divide Records to Separate Files 
 

Menu Steps 
 

1. Choose the After Filtering menu 
2. Choose the Divide command 
3. Specify a record file 
4. Specify a name for the output file 

 

Command Button 
 

You may also activate dividing more directly by clicking the Divide command button. 



 

What is a Record File? 
 

Once you have filtered a captured search file, you have a record file with a .PRO extension. You might have reason 

to sift, edit, copy, join, split, rename or query these record files.  Any of the resulting files containing numbered 

record labels in the form 
 

Record - 1 

 

are record files. 
 

Why Divide? 
 

Dividing individual records into separate files can be useful as a step in prepartion for importing the data into 

various other software. 
 

What Dividing Does 
 

Dividing creates a series of new files, each containing just one record.  For example, if SEARCH.PRO contains ten 

records, ten new files will be created.  Each will have the same base file name, SEARCH, with numerial file name 

extension in ascending order, SEARCH.001, SEARCH.002, SEARCH.003, etc.  The input file, SEARCH.PRO will 

remain unaltered. 

 

14.  Undelimit 
 
Menu Steps 
 

1. Choose the After Filtering menu 

2. Choose the Undelimit command 

3. Specify a record file containing DIALOG TAGed records 
 

Command Button 
 

You may also activate undelimiting more directly by clicking the Undelimit command button. 
 

What is a Record File? 
 

Once you have filtered a captured search file, you have a record file with a .PRO extension. You might have reason 

to sift, edit, copy, join, split, rename or query these record files.  Any of the resulting files containing numbered 

record labels in the form 
 

Record - 1 

 

is a record file. 
 

DIALOG TAGed Records 
 

While searching DIALOG, add the TAG option to your TYPE command.  Instead of getting records like this: 
 

?t s3/l/all 

 

3/L/1 

DIALOG(R)File   1:ERIC 

(c) format only 1995 Knight-Ridder Info. All rts. reserv. 

 

EJ426056   IR522936 

  The Seven Stages of an Online Search--Part I. 

  Quint, Barbara 

  Online; v15 n3 p13-18 May 1991 

  ISSN: 0146-5422 

  Available from: UMI 

  Language: English 

  Document  Type: JOURNAL ARTICLE (080); CLASSROOM MATERIAL (050); POSITION 



PAPER (120) 

  Journal Announcement: CIJSEP91 

  Discussion of online searching focuses on the first three of seven stages 

of searching: (1) the reference interview, including user needs, the search 

request,  and the user's expectations; (2) the tactical overview, including 

institutional control and cost and time factors; and (3) database selection 

considerations, including relevance, accessibility, and costs. (LRW) 

  Descriptors:  Cost  Effectiveness;  Costs; Databases; Interviews; *Online 

Searching;  Relevance  (Information  Retrieval);  *Search  Strategies; Time 

Management; *User Needs (Information) 

  Identifiers: *Query Negotiation (Library Science); User Fees 

 

you will get records like this: 
 

?t s3/l/all tag 

 

3/L/1 

FN- DIALOG(R)File   1:ERIC| 

CZ- (c) format only 1995 Knight-Ridder Info. All rts. reserv.| 

SO- <AN> EJ426056| 

SO- <AN> IR522936| 

TI- The Seven Stages of an Online Search--Part I.| 

AU- Quint, Barbara| 

SO- <JN> Online^v15 n3 p13-18 May | 

SO- <PY> 1991| 

SN- 0146-5422| 

AV- UMI| 

LA- English| 

DT- JOURNAL ARTICLE (080); CLASSROOM MATERIAL (050); POSITION PAPER (120)| 

JA- CIJSEP91| 

AB- Discussion of online searching focuses on the first three of seven 

    stages of searching: (1) the reference interview, including user needs, 

    the search request, and the user's expectations; (2) the tactical 

    overview, including institutional control and cost and time factors; 

    and (3) database selection considerations, including relevance, 

    accessibility, and costs. (LRW)| 

DE- Cost Effectiveness^Costs^Databases^Interviews^*Online 

    Searching^Relevance (Information Retrieval)^*Search Strategies^Time 

    Management^*User Needs (Information)| 

ID- *Query Negotiation (Library Science)^User Fees|| 

 

What Undelimiting Does 
 

Dialog TAGed records contain field and record delimiters.  The field delimiter is a single vertical bar at the end of 

the field data.  The record delimiter is a double vertical bar at the end of the record.  Undelimiting does just one 

thing:  produce a new output file in which the data is entirely unaltered except that the field and record delimiters are 

gone.  This can be useful, for example, when you want the field tags along the left but do not want the delimiters. 

 

15.  Header/Cover Page 
 
The Header/Cover Page command lets you attach a stylized memo documenting the search to a data file either as a 

header or as a separate cover page, or save the memo as a separate file. 

 

The Header/Cover Page form provides a number of options to suit various reporting environments, e.g., corporate 

libraries, independent research firms, etc.  The format of the memo is somewhat different when the “Research Firm” 

option is in effect. 

 

Below is an example of output with the “Research Firm” option in effect. 
 

ProFound Research, LLC 

HC56, Box 6038 

Sidney, MT 59270 USA 

 

Client:    Acme Client, Incorporated 

 

Subject:   Determinants of Protein Content in Hard Red Spring Wheat 

 

June 14, 1995     Job No.:  HRS-2829 

 

Database(s) and Date(s) Searched: 

 

   Agricola thru May 31, 1995 

   CAB Abstracts thru June 7, 1995 

 

Memo: 

 

   This search, forming one part of this ongoing project, was 



   limited to issues of timing of application of Nitrogen-bearing 

   artificial fertilizers.  The literature referenced in the 

   enclosed records originating in various countries around the 

   world indicates that application during plant growth is superior 

   to application at or before sowing.  The spike stage, and 

   several stages just before and just after the spike stage appear 

   to be the optimum time of application. 

 

Below is an example of output with the “Library” option in effect. 

 
Requester:  John E. Deere, Grower Services Director 

 

Library:    Product Development Information Center 

            Corinth Milling Company 

 

Subject:   Determinants of Protein Content in Hard Red Spring Wheat 

 

Date:      June 14, 1995 

 

Database(s) and Date(s) Searched: 

 

   Agricola thru May 31, 1995 

   CAB Abstracts thru June 7, 1995 

 

Memo: 

 

   This search, forming one part of this ongoing project, was 

   limited to issues of timing of application of Nitrogen-bearing 

   artificial fertilizers.  The literature referenced in the 

   enclosed records originating in various countries around the 

   world indicates that application during  plant growth is 

   superior to application at or before sowing.  The spike stage, 

   and several stages just before and just after the spike stage 

   appear to be the optimum time of application. 

 

Click on the suitable option button for the “to” field of the memo: 

 

 
 

Click on the suitable option button for the “from” field of the memo: 

 

 
 

Type in the text boxes to complete the memo as desired.  When satisfied, click on the suitable option button for the 

save option: 

 

 
 

Then save the memo by choosing the Save command. 

 

To avoid repetitive work when creating headers and cover sheets, the form provides a Save .INI command. 

 

 
 



Executing this command will save the current “to” and “from” option button settings, the current save option button 

setting, and the current contents of the “to” and “from” text boxes to a file called POSTWIN.INI in the installation 

directory.  In subsequent uses of the Header/Cover Page command, those setting and text boxes will automatically 

be displayed. 

 

16.  View Files 
 
Menu Steps 
 

1. Choose the File menu 

2. Choose the View command 

3. Specify a file to view 
 

Command Button 
 

You may also activate the file viewer more directly by clicking the File Viewer command button. 
 

Uses of File Viewer 
 

This facility is useful, for example, to look into the contents of a file to see if it is the log you want to filter, to 

review DIALOG record types before deciding which DIALOG filtering option to use, view the results of filtering, 

keeping, reordering, selecting records by key words, or any other file viewing purpose. 
 

Browsing 
 

Certain browsing keys are active, including Down Arrow, Up Arrow, PgDn, PgUp, Ctrl-PgDn, Ctrl-PgUp, Home 

and End.  Files can also be browsed using the mouse on the scroll bar. 
 

Searching 
 

The Search menu provides commands to search the file for text, repeat the search, jump to a line by number and 

step through filtered record files record-by-record. 
 

These commands are also available by keyboard shortcuts, as follows 
 

Find Text  F2 

Repeat Search F3 

Jump to Line F4 

Record Stepper F8 
 

and by command button 
 

Copy 
 

The file viewer enables you to copy text to the Windows clipboard.  From there you can paste the text into other 

Windows applications by using the paste command of those applications.  The Copy command is available by menu, 

keyboard shortcut and command button. 

 

17.   Split Files 
 
Sometimes it can be beneficial to split files.  For example, the index capacity of the sifting, querying, ranking and 

sorting is 2000 records.  If you have a filtered record file of more than 2000 records, you might want to split the file 

into two smaller ones to allow all the records to be sifted, queried or sorted. 
 

The Split command is implemented in the file viewer to let you see where the split will occur.  Activate the file 

viewer and open the file you want to split.  Browse to the section of the file where you want the split to occur and 



highlight the line you want as the first line of the second split file or, in other words, the line just after the one you 

want as the last line of the first split file.  Then chose the Split command. 
 

The command opens a dialog which lets you specify the first and second split file names. 
 

 

When satisfied with the file names, choose the dialog’s Split command.  PostSearch™ will copy the first segment of 

the input file to the first split file and the remaining segment to the second split file, without altering the input file. 

 

Settings 
 

18.1  Working Directory 
 
The first time you run PostSearch™, the working directory will be the installation directory.  By default, in future 

sessions PostSearch™ will remember the directory where you were working when you finished your last session and 

sett that directory as your initial working directory for the new session.  This saves you the trouble of navigating 

around in the File Open dialog. 
 

As an alternative, you might want to set a start-up working directory to override whatever was the last working 

directory.  This lets you start in a specified directory regardless where you might have finished the last session.  The 

Settings command will open a dialog letting you configure this option.  The dialog also lets you reverse the override 

if you later decide to let PostSearch™ use the last working directory as the start-up working directory. 

 

18.2  Font in Sifter and File Viewer 

 
The sifter and the file viewer allow you to set the font used to display data.  Choose the Font command on the 

Options menu. 

 

Two-Step Process 
 

The Font command takes you through a two-step process.  In the second step, it uses the Windows Font common 

dialog.  Before displaying the Font common dialog, however, the Font command displays a Font Options dialog to 

give you more control over which fonts are listed in the Font common dialog and to let you specify whether the new 

font setting will be saved for future sessions or used only for the current session. 

 



 

Listing All Fonts 
 

When the Font Options dialog appears, if you just click the Okay button, the Windows Font common dialog will list 

all installed and registered fonts. 

 

Limiting Listed Fonts 
 

The Font Options dialog provides three check boxes which let you limit the fonts to be listed in the Windows Font 

common dialog.  You can check one or more of the check boxes. 

 

• Screen Fonts Only 

causes the Windows Font common dialog to list only the screen fonts supported by the system 

• Fixed Fonts Only 

causes the Windows Font common dialog to list only fixed pitch fonts (not proportionally spaced 

fonts) 

• ANSI Only 

causes the Windows Font common dialog to list only fonts that use the Windows character set 

(fonts containing only symbols will not be listed) 
 

Save Setting or Session Only 
 

The Font Options dialog provides two option button which let you specify whether the new font setting will be 

saved for future sessions or used only for the current session.  These two options are mutually exclusive.  Click the 

option you want before clicking the Okay button. 
 

Windows Font Dialog 
 

When you click the Okay button, Windows will display its Font common dialog listing the installed and registered 

fonts allowed by your choices on the Font Options dialog.  Click on the Font, Font Style and Size of your choice, 

and then on the OK button. 

 



 

19.  Naming Files 
 
PostSearch™ creates a number of files using the base file name of your input file plus a three-character DOS file 

name extension. 
 

.PRO filtering 

.NDX filtering, sifting and selecting records by key words 

.FSC files, sets costs information created by the filters for DIALOG searches 

.ORD reordered records created by the sifter 

.RNK ranked records 

.TBL rank tables 

.SRT records sorted on a tagged field 

.DIC diction table 

.FMT reformatting DIALOG TAGed records to remove hard carriage returns within paragraphs 

.BRK inserting page breaks 
 

You would want to avoid using any of these file name extensions as input file names. 

 
LIMITED WARRANTY 
 
LIMITED WARRANTY.  Pastel Programming Co. warrants that the software will perform substantially in accordance with the accompanying written materials for a 

period of ninety (90) days from the date of receipt.  Any implied warranties on the software are limited to ninety (90) days.  Some states/countries do not allow 

limitations on durations of an implied warranty, so the above limitation may not apply to you. 

 
CUSTOMER REMEDIES.  Pastel Programming Co. and its suppliers' entire liability and your exclusive remedy shall be, at Pastel's option, either (a) return of the 

price paid, or (b) replacement of the software which is returned with a copy of your receipt.  The Limited Warranty is void if failure of the software has resulted from 

accident, abuse, or misapplication.  Any replacement software will be warranted for the remainder of the original warranty period or thirty (30) days, whichever is 

longer. 

 
NO OTHER WARRANTIES.  Pastel Programming Co. and its suppliers disclaim all other warranties, either express or implied, including, but not limited to implied 

warranties of merchantability and fitness for a particular purpose, with regard to the software and the accompanying written materials.  The Limited Warranty gives 

you specific legal rights.  You may have others which vary from state/country to state/country. 

 
NO LIABILITY FOR CONSEQUENTIAL DAMAGES.  In no event shall Pastel Programming or its suppliers be liable for any direct, indirect, consequential or 

incidental damages whatsoever including, without limitation, damages for loss of business profits, business interruption, loss of business information, and the like, or 

any other pecuniary loss arising out of the use of or inability to use the software, even if Pastel has been advised of the possibility of such damages.  Because some 

states/countries do not allow the exclusion or limitation of liability or incidental damages, the above limitation may not apply to you. 

 

 


